
PT-P710BT User’s Guide (English)

Version 01 

C1

Please read this guide, including all Precautions, before using this label printer. After reading this guide, keep it in 

a safe place.

Supplies

Brother TZe Tape Cassette

Compatible widths

0.13, 0.23, 0.35, 0.47, 0.70, 0.94 in.

3.5, 6, 9, 12, 18, 24 mm

Head Cleaning Tape Cassette TZeCL4

Rechargeable Li-ion Battery PA-BT-005

• Brother reserves the right to make changes without notice in the specifications and materials contained herein 

and shall not be responsible for any damages (including consequential) caused by reliance on the materials 

presented, including but not limited to typographical and other errors relating to the publications.

• Unauthorized duplication or reproduction of any or all content of this document is prohibited.

• Please note that we cannot assume any responsibility for any damage or lost profit arising from the use of the 

label created with this label printer or the disappearance or change of data due to failure, repair or consumables 

using battery, or any claim from a third party.
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1

Safety Precautions 1

Follow these guidelines to avoid the risk of heat generation, smoking, explosion, fire, or injury.

DANGER Failure to observe instructions and warnings will result in death or serious injuries.

Rechargeable Li-ion Battery

• Do not allow the battery to come into contact with liquids.

• Do not charge, use, or leave the battery in high temperature (above 140°F / 60°C) locations.

• Use the included USB cable to charge.

• Use the battery only for its intended purpose.

• Keep the battery away from heat and fire.

• Do not connect the + and - terminals with metal objects such as wire. Do not carry or store the battery with metal 

objects.

• Do not throw, hit or damage the battery in any way.

• Do not solder any connections to the battery.

• Do not disassemble or modify the battery.

• Do not dispose of the battery with household waste.

WARNING Failure to observe instructions and warnings could result in death or serious injuries.

Rechargeable Li-ion Battery

• Keep the battery away from infants. If the battery is ingested, seek immediate medical advice.

• Stop using the battery if there are noticeable abnormalities such as smell, heat, deformities, or discoloration.

• If liquid from the battery gets into your eyes, wash them with clean water and see a doctor immediately.

Label Printer and USB Cable

• Use the included USB cable to prevent any damage.

• Do not use during a thunderstorm.

• Do not damage.

• Do not place heavy objects on.

• Do not forcibly bend or pull.

• Do not disassemble or modify.

• Do not drop or hit.

• Do not allow to come into contact with liquids.

• If you notice abnormalities such as smell, heat generation, discoloration, or deformation while in use or storage, 

stop using the label printer, disconnect the USB cable, and remove the battery.

• When the label printer is not being used, store it out of the reach of children. In addition, do not allow children to 
put any label printer parts or labels in their mouths. If ingested, seek immediate medical advice.

1 Precautions
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CAUTION Failure to observe instructions and warnings could result in minor or moderate injuries.

Precautions 

2

Rechargeable Li-ion Battery

If liquid from the battery gets onto skin or clothes, immediately rinse them with water.

Label Printer and USB Cable

• Use the dedicated battery (PA-BT-005).
• When opening and closing the Cassette Cover, use caution to prevent your fingers from being trapped.
• Do not touch the Print Head.
• Do not touch the cutter blade or insert your fingers inside the Tape Exit Slot.

General Precautions 1

Label Printer, Tape Cassette, or USB Cable

• Do not use in any way or for any purpose not described in this guide. Doing so may result in accidents or damage.
• Use Brother  Tape Cassettes.
• Do not put any foreign objects into the Tape Exit Slot, the USB Port, battery compartment, etc.
• Do not place in any location exposed to extremely high or low temperatures, high humidity, or dust, such as direct 

sunlight, rain, near heaters, other hot appliances, on the dashboard, or in the back of your car.
• Do not try to print if the cassette is empty; it will damage the Print Head.
• Do not pull the tape while printing or feeding; it will damage the tape and the label printer.
• The length of a printed label may differ from the displayed label length.
• Depending on the location, material, and environmental conditions, labels may unpeel or become irremovable, or 

the color may change or be transferred to other objects. Before applying labels, check the environmental conditions 
and the material.

• When printing multiple copies of a label, the label printer will not detect the end of the tape cassette and will 
continue printing.

• Printed characters may look different than previewed, as your device's or computer’s screen may have a higher 
resolution than the label printer.

• Printed small text may not be as clear as it is displayed.
• White and Gold printed objects may not always print clearly.
• The backing of some types of tapes may be pre-cut to make it easier to peel the backing. To remove the backing, 

simply fold the label lengthwise with the text facing inwards to expose the inside edges of the backing. Next, peel 
off the backing one piece at a time.

• Labels may be difficult to attach to surfaces that are wet, dirty, or uneven. The labels may peel off easily from these 
surfaces.

• For rough and textured surfaces, we recommend using Extra Strength Adhesive Tape.
• Be sure to read the instructions provided with Fabric Tapes, Extra Strength Adhesive Tapes, or other special tapes 

and observe all precautions noted in the instructions.
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3

Parts Description 2

Power LED

Tape Exit Slot

Power Button 

Battery LED 

USB Port 

Cassette Cover

Tape Guide

End of Tape

2 Set Up Your Label Printer
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Set Up Your Label Printer 

4

Insert the Tape Cassette 2

a Place your fingers on the Tape Exit Slot.

b Open the Cassette Cover by pulling the Tape 
Exit Slot to the left.

Pull out the 

protective sheet

(first time only).

c Confirm that the tape is pointed at the Tape 
Exit Slot and gently press the Tape Cassette 
into the label printer until it locks into place.

• Make sure that there is no slack in the tape. To 

fix any slack, pull the end of the tape out of the 

Tape Guide.

• When inserting or removing the Tape Cassette, 

make sure that the tape does not catch on the 

label printer.

d Close the Cassette Cover.
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Set Up Your Label Printer 

5

Charge the Battery 2

USB AC Adapter
(not included)
5 V DC, 0.5 A – 2 A

USB Port 
(on computer)
5 V DC, 0.5 A – 2 A

Connect the label printer to the computer using the included USB cable, or connect the USB cable to a USB AC 

Adapter suitable for charging mobile devices, and plug the adapter into a power source. Charge until the Battery 

LED turns off.

• Use the included USB cable.

• If charging the battery using a computer, make sure the computer is on.

Notes on Using the Rechargeable Li-ion Battery

• Charge the battery in environments between 50°F and 95°F / 10°C and 35°C, otherwise the battery will not charge, 

and the Battery LED will remain lit.

• If the label printer is used to print, feed, or perform another operation while charging, charging may stop even 

though the battery is not fully charged. Charging resumes when the operation is completed.

Rechargeable Li-ion Battery Characteristics

To ensure the highest performance and longest life from the rechargeable Li-ion Battery, when storing the label 

printer for a long period of time:

• Charge once every six months.

• Store in a cool dry place out of direct sunlight, between 50°F and 95°F / 10°C and 35°C.

www.calcert.com sales@calcert.com1.888.610.7664
0

5

10
15

20

25

30



Battery Cover

a Turn the label printer off.

b Open the Cassette Cover.

c Remove the two screws from the Battery Cover 
using a flat-bladed screwdriver.

d Remove the battery.

• Dispose of batteries at an appropriate collection 

point. Be sure to observe all applicable local 

regulations.

• When storing or discarding a battery, cover the 

contacts with cellophane tape to prevent it from short-

circuiting.

Do not dispose of the battery with household waste.
There is a risk of environmental damage, explosion, or fire.

e When reinserting the battery, make sure the 
battery's contacts are touching the contacts 
inside the battery compartment.

f Replace the Battery Cover, reinsert the screws, 
and tighten them with a flat-bladed screwdriver.

g Close the Cassette Cover.

Set Up Your Label Printer 

6

Remove Battery for Replacement or Disposal 2

CAUTIONCAUTIONCAUTIONDANGER
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Set Up Your Label Printer 

7

Turn Power On or Off 2

Power On Press the Power Button.

Power Off Press and hold the Power Button until the Power LED turns off.
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• Press the Power Button twice quickly to feed and cut the tape.

• When the Auto Cut option is selected, the minimum print length is 0.98 in. / 25 mm.

• Before each initial print, the label printer feeds an approximately 1 in. / 25 mm of blank tape.

• We recommend not selecting the Auto Cut option when printing multiple labels less than 0.98 in. / 25 mm. This 

will save tape.

8

Download the P-touch apps from the App Store or Google Play™.

iPrint&Label Create labels for business use, including 

barcodes, office equipment labels, and labels for 

folder tabs.

P-touch Design&Print Design and create stylish labels for work or home.

3 Print from Your Mobile Device
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Print from Your Mobile Device 

9

Pair the Label Printer with Your Mobile Device 3

On your mobile device:

a Go to the settings menu and make sure the Bluetooth® option is on.

b Select PT-P710BT**** (where **** is the last four digits of your label printer’s serial number. The unit's 
serial number is located inside the Cassette Cover, underneath the TZe Tape Cassette.).

• If asked to enter a PIN Code, enter "0000".

• Pairing instructions may differ slightly, depending on your mobile device.

• If your label printer is not found by your mobile device, your label printer may already be connected to another 

device. If so, turn off Bluetooth on that device, or turn your label printer off and then on again.

• This label printer does not support Wi-Fi connections.

• If your label printer is not found by your mobile device, make sure the label printer is not in sleep mode.
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10

Visit install.brother and install the printer driver and P-touch Editor by following the on-screen instructions.

The following software can be selected 
for installation: Features

Printer Driver Software required to print from a label printer.

P-touch Editor

Label creation software for computers. This application comes with 

built-in drawing tools that allow you to print a wide variety of custom 

labels in complex layouts with text of different fonts and styles, frames, 

imported images, barcodes, etc.

P-touch Update Software
Update applications to the latest version.

Visit  to update P-touch Editor for Mac.

Printer Setting Tool Configure settings for the label printer.

4 Print from Your Computer
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Print from Your Computer 

11

Windows 4

Create Labels with P-touch Editor 4

a Connect the label printer and your computer with the included USB cable.

b Double-click the P-touch Editor icon  on the desktop. 

c Create a new layout or open an existing layout. 

d Select the mode as necessary:

Mode Features Print Settings 
Change How to Print

Express This mode allows you to quickly create 
layouts that include text and images.

Yes Click the print icon  > Print

Yes File menu > Print > Print

Professional
This mode allows you to create layouts 
using a wide-range of advanced tools 
and options.

No Click the print icon . 

Yes File menu > Print > Print

Yes Click the print icon  > Print

Snap

This mode allows you to create custom 
layouts at any time by keeping the P-
touch Snap palette displayed on your 
monitor.
• Screen Capture function
• Drag-and-Drop function
• Print Text function

No

Click the print icon . 

Options Functions (Multiple selection is possible for some options) 

Auto Cut Cuts each label automatically.

Chain Printing Allows you to save tape by not cutting the last label.

Special tape
Feeds tape for manual cutting. Use for special tapes, such as Fabric Tapes and Extra 

Strength Adhesive Tapes.

Mirror Printing Print reverse.

• Press the Power Button twice quickly to feed and cut the tape.
• When the Auto Cut option is selected, the minimum print length is 0.98 in. / 25 mm.
• Before each initial print, the label printer feeds an approximately 1 in. / 25 mm of blank tape.
• We recommend not selecting the Auto Cut option when printing multiple labels less than 0.98 in. / 25 mm. This 

will save tape.
• The Cable Labeling Wizard allows you to create layouts for electrical equipment management.
• This label printer does not support Bluetooth connections for computers.

To select the layout
- Double-click the layout icon.
- Select the layout icon, then click the arrow mark . 

To change the P-touch Editor startup settings
a Click the Tools menu, and select > Options.

b In the Options window, select General and select the startup setting you want from Operations. 
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Print from Your Computer 

12

Configure Settings Using the Printer Setting Tool 4

a Connect the label printer and your computer with the included USB cable.

b Start the Printer Setting Tool.

Operating System 
Version How to Start

Windows 7 Start > All Programs > Brother > Label & Mobile Printer > Printer Setting Tool

Windows 8

Windows 8.1 
Apps > Printer Setting Tool

Windows 10 Start > Brother > Printer Setting Tool

c Click Device Settings. 

The following settings can be changed:

Auto Power On
Configure whether the label printer turns on automatically when it is connected to a 

USB AC adapter or a computer.

Auto Power Off 
Set the period of time before the label printer turns off automatically when it is 

connected to a USB AC adapter or a computer.

Auto Power Off (Li-ion) Set the period of time before the label printer turns off automatically.

Contents Configure the label printer information that will be printed.

Length Adjustment
Adjust the length of the printed label to match the length of the label displayed on the 

computer.

d Click Apply > Exit.

e Click Exit in the main window.

• Check that the label printer you want to configure appears next to Printer. If a different label printer appears, 

select your label printer from the drop-down list.

• Do not perform another job while changing the settings.
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Print from Your Computer 

13

Apply Settings Changes to Multiple Label Printers 4

a After applying settings to the first label printer, disconnect the label printer from the computer.

b Connect the second label printer to the computer.

c Select the newly connected label printer from the Printer drop-down list.

d Click Apply. 

Repeat steps a to d for all label printers whose settings you want to change.

• To save the current settings in a file, click File > Export.

• The same settings can be applied to other label printers. Click File > Import, then select the exported file.

Update Software 4

a Double-click the P-touch Update Software icon  on the desktop.

b Click the Computer software update icon . 

c Select the Printer and Language, select the check boxes next to the software you want to update, 
and then click Install.

Close all other Brother applications.

Update Firmware 4

a Turn on the label printer, and connect it to your computer with the included USB cable.

b Double-click the P-touch Update Software icon  on the desktop.

c Click the Machine update icon . 

d Select the Printer, ensure that The machine is connected correctly. appears, and then click OK.

e Select the Language, select the check boxes next to the firmware you want to update to, and then 
click Transfer.

f Click Start.

• Do not power off or disconnect the USB cable while updating.

• Close all other Brother applications.
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Print from Your Computer 

14

Mac 4

Create Labels with P-touch Editor 4

a Connect the label printer and your computer with the included USB cable.

b Click Macintosh HD > Applications > P-touch Editor.

c Select a new template or a template category.

• Press the Power Button twice quickly to feed and cut the tape.

• When the Auto Cut option is selected, the minimum print length is 0.98 in. / 25 mm.

• Before each initial print, the label printer feeds an approximately 1 in. / 25 mm of blank tape.

• We recommend not selecting the Auto Cut option when printing multiple labels less than 0.98 in. / 25 mm. This 

will save tape.

• This label printer does not support Bluetooth connections for computers.

Configure Settings Using the Printer Setting Tool 4

a Connect the label printer and your computer with the included USB cable.

b Click Macintosh HD > Applications > Brother > Printer Setting Tool > Printer Setting Tool.

c Select any of the Settings tabs, and then configure the settings.

d Click Apply Settings to the Printer.

e Click Exit.

• Check that the label printer you want to configure appears next to Printer. If a different label printer appears, 

select the label printer from the drop-down list.

• Do not perform another job while changing the settings.

Auto Power On
Configure whether the label printer turns on automatically when it is connected to a 

USB AC adapter or a computer.

Auto Power Off
Set the period of time before the label printer turns off automatically when it is 

connected to a USB AC adapter or a computer.

Auto Power Off (Li-ion) Set the period of time before the label printer turns off automatically.

Length Adjustment
Adjust the length of the printed label to match the length of the label displayed on the 

computer.
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Print from Your Computer 

15

Apply Settings Changes to Multiple Label Printers 4

a After applying settings to the first label printer, disconnect the label printer from the computer.

b Connect the second label printer to the computer.

c Select the newly connected label printer from the Printer drop-down list.

d Click Apply Settings to the Printer.

Repeat steps a to d for all label printers whose settings you want to change.

• To save the current settings in a file, click Export.

• The same settings can be applied to other label printers. Click Import, then select the exported file.

Update Firmware 4

a Turn on the label printer, and connect it to your computer with the included USB cable.

b Click Macintosh HD > Applications > P-touch Update Software.

c Click Machine update.

d Select the Printer, ensure that The machine is connected correctly. appears, and then click OK.

e Select the Language, select the check boxes next to the firmware you want to update to, and then 
click Transfer.

f Click Start.

• Do not power off or disconnect the USB cable while updating.

• Close all other Brother applications.
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16

Maintenance 5

Before performing any maintenance, disconnect the USB cable and power off the label printer.

Clean the Label Printer Exterior 5

Wipe the label printer’s exterior with a soft, dry cloth to remove dirt or dust. If the label printer is heavily soiled, wipe 

it with a cloth dampened with some water.

Do not use solvents or agents such as benzene, paint thinner, or alcohol, which may damage the label printer’s 

surface.

Clean the Print Head 5

Streaks or poor-quality characters on printed labels generally indicate that the print head is dirty.

You can use either the optional dedicated Head Cleaning Tape Cassette (TZe-CL4) or a cotton swab to gently 

wipe dirt from the Print Head.

Put the Head Cleaning Tape Cassette in the label printer, and press the Power Button twice quickly. 

Approximately 1 in. / 25 mm of tape feeds each cleaning cycle.  If the problem is not solved after repeating this 

process three times, contact Brother customer service.

Print Head

Do not touch the Print Head. You may get burned.

5 Appendix

CAUTIONCAUTIONCAUTIONCAUTION
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Appendix 

17

Clean the Tape Cutter 5

Tape adhesive can build up on the cutter blade after repeated use, taking the edge off the blade which may result 

in the tape jamming in the cutter. Wipe the cutter blades using a cotton swab moistened with ethanol or isopropyl 

alcohol.

Do not touch or insert your fingers into the cutter blade.CAUTIONCAUTIONCAUTIONCAUTION
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Troubleshooting 5

Power LED Lit/Flashing Condition

Green

Lit

• Bluetooth connection established

• Feeding or cutting tape

• Printing

Flashing 

(0.5 second intervals)

• Receiving data from a mobile device or a computer

• Transferring program

Lit for 3 seconds, then off 

for 1 second
Standby

Orange

Lit Initializing

Flashing 

(0.5 second intervals)
Cooling

Battery LED Lit/Flashing Condition

Orange

Not lit Fully charged

Lit Charging

Not lit for 3 seconds, then 

lit for 0.5 seconds
Only half the battery charge remains.

Not lit for 2 seconds, then 

flashing twice
The battery charge is low.

Flashing 

(0.5 second intervals)

Insufficient charge or battery failure.

Refer to the following table to solve the problem.

LED Indications 5
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Power 
LED  

Lit/
Flashing Condition How to Clear 

an Error Solution

Red

Flashing twice 

per second, 

then off for 1 

second

• Insufficient charge

• Battery failure

Lightly press the 

Power Button.

Charge the battery.

If the problem is still not resolved, 

replace the battery.

Flashing 
(1 second 

intervals)

• No Tape Cassette installed.

• Incorrect Tape Cassette 

installed.

• Incompatible Tape Cassette 

installed.

Insert the correct Tape Cassette.

High temperature error

Wait a short while, then try again 

after the Power LED changes to 

green.

Transmission error
Restart the label 

printer.

When using a mobile device:

Establish a Bluetooth connection.

When using a computer:

• Reconnect the USB cable.

• Change the USB port.

Cutter error Restart the label printer.

Lit Program transfer failure

Transfer the program again.

If the problem is still not resolved, contact Brother 

customer service.

Flashing 
(0.3 second 

intervals)

System error

Contact Brother customer service.

(The flashing pattern may change if you touch the 

Power Button.) 

Appendix 
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LED Troubleshooting 5
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Appendix 
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If you need additional help, visit 

Problem Solution

The label printer does not print.

• Check that the Tape Cassette is inserted correctly. 

• If the Tape Cassette is empty, replace it.

• Check that the Cassette Cover is securely closed.

• Check that the charge is not low.

• Check that the label printer is on.

• Check that the mobile device is not in sleep mode.

• Check that the mobile device’s Bluetooth setting is on.

• Check that the label printer is connected to your mobile device via Bluetooth. 

• Check that the label printer is selected in the P-touch app.

• Check that the label printer is not paired with another device.

• Make sure the label printer and your mobile device are close enough to 

communicate.

• Make sure no devices that emit radio waves (for example, a microwave oven) are 

located nearby.

• Check that the correct printer driver is installed when printing from a computer.

• Connect the label printer to your computer with the included USB cable when 

printing from a computer.

• Check the label is not blank. 

• The tape does not feed 

correctly.

• The tape gets stuck inside the 

label printer.

• If the tape is bent, cut off the bent section. 

• If the tape is jammed, remove the tape cassette, pull out the jammed tape, and 

then cut it.

• Check that the end of the tape out of the Tape Guide. 

• Confirm that the tape is pointed at the Tape Exit Slot. 

• Remove the tape cassette and insert it again.

A tape jam error cannot be 

cleared despite following the 

troubleshooting steps.

Contact Brother customer service.

A horizontal gap runs through 

the middle of the printed label.

Streaks or poor quality printed labels generally indicate that the Print Head is dirty. 

See Maintenance: Clean the Print Head.

An error occurred when using a 

mobile app.

Go to your mobile app’s settings menu > Support page > FAQs & 

Troubleshooting

I want to cancel the current 

printing job.
Make sure that the label printer is on, and then lightly press the Power button.

The ink ribbon is separated 

from the ink roller.

If the ink ribbon is broken, replace the tape cassette. 

If not, leave the tape uncut and remove the tape cassette, then wind the loose ink 

ribbon back onto the spool.

1Spool
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The label printer stops while 

printing a label.

Replace the tape cassette if striped tape is visible, as this indicates that you have 

reached the end of the tape.

While printing, striped tape 

appears.
The tape cassette is empty. Insert a new tape cassette. 

The tape is not cut 

automatically.

Select Auto Cut.

If using special tapes, cut the tape by hand.

Printed barcodes or QR codes 

cannot be read.

• Try using another barcode scanner.

• Try using another QR code reader application. 

• Change the tape. 
Recommended: Black on white tape 

• Enlarge barcodes or QR codes using the application, if possible.　

There is an approximately 1 in. 

/ 25 mm of blank space at the 

leading edge of each printed 

label.

Most TZe labels have a clear laminate top layer. This durable laminate helps the 

label withstand abrasion, fading and wet conditions providing a crisp, readable 

image. The process of adding this laminate layer results in the leading edge of 

blank space. Adjusting the label’s margin or not cutting the last label may reduce 

the amount of blank space.

• I cannot turn on the label 

printer.

• The label printer powers off 

when I try to print.

• The battery may be discharged. Charge it.

• Make sure you have removed the protective sheet. See Insert the Tape Cassette.

It is not possible to charge the 

battery.

• Disconnect the USB cable and connect it again.

• Make sure you have removed the protective sheet. See Insert the Tape Cassette.

Battery life is short, even when 

fully charged.
The battery may have reached the end of its life. Use a new battery. 

I want to check I am using the 

latest version of the software.

Windows

Use the P-touch Update Software to confirm if you have the latest version. See 

Windows: Update Software.

Mac

See 

Problem Solution
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Product Specifications 5

Dimensions Approximately 5 in. (W) x 2.6 in. (D) x 5 in. (H)

Approximately 128 mm (W) x 67 mm (D) x 128 mm (H)

Weight (with battery) Approximately 1.4 lb

Approximately 640 g

Operating temperature 50°F to 95°F 

10°C to 35°C

Operating humidity 20% to 80% (without condensation) 

Interface Label printer side 

(for Windows/Mac)

USB 2.0 Full Speed

Bluetooth Version 2.1 +EDR Class2
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Trademarks 5

Mac and Macintosh are trademarks of Apple Inc.

App Store is a service mark of Apple Inc.

Google Play is a trademark of Google LLC.

The Bluetooth® word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any use of 

such marks by Brother Industries, Ltd. is under license. 

Wi-Fi is a registered trademark of Wi-Fi Alliance®.

Any trade names and product names of companies appearing on Brother products, related documents and any 

other materials are all trademarks or registered trademarks of those respective companies.
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